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Resumo 
O presente trabalho tem como área de estudo o município de Jaú, localizado no estado de São Paulo, 

onde se encontram os aquíferos Bauru, Guarani e o Serra Geral, este último o mais significativo na área. 

A metodologia envolveu a aplicação do Índice de Susceptibilidade (IS) com o objetivo de avaliar as áreas 

mais susceptíveis à contaminação de aquíferos no município. O que difere este índice dos demais é a 

utilização de dados referentes ao uso e cobertura do solo, sendo um atributo fundamental para a área de 

estudo, a qual possui grandes extensões de cultivo agrícola, especificamente cana-de-açúcar. Nos 

resultados, foi possível identificar a importância desse atributo e sua relevância para a classificação de 

susceptibilidade dos aquíferos à contaminação e, quando associado com os outros atributos ambientais 

(declividade, recarga líquida, unidades aquíferas e profundidade do nível da água) utilizados no cálculo 

do IS, mostrou-se determinante para a classificação da área. Por meio do cálculo do índice, obteve-se 

uma classificação de alto risco em 57,61% da área territorial do município. O método utilizado para o 

cálculo da susceptibilidade à contaminação dos aquíferos mostrou-se eficiente e condizente para 

adequada gestão ambiental do município. 

Palavras-chave: Índice de Suscetibilidade. Contaminação. Unidades Aquíferas. Recursos 

Hídricos. SIG. 
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Abstract 

The present study area is the municipality of Jaú, located in the state of São Paulo, where the 

Bauru, Guarani and Serra Geral aquifers are found, the latter being the most significant in the area. 

The methodology involved the application of the Susceptibility Index (SI) in order to evaluate the 

areas most susceptible to contamination of aquifers in the municipality. What differs this index 

from the others is the use of data regarding the land use and land cover, being a fundamental 

attribute for the study area, which has large extensions of agricultural cultivation, specifically 

sugarcane. In the results, it was possible to identify the importance of this attribute and its 

relevance for the classification of susceptibility of aquifers to contamination and, when associated 

with the other environmental attributes (slope, liquid recharge, aquifer units and depth of water 

level) used in the calculation of IS, proved to be determinant for the classification of the area. By 

calculating the index, we obtained a classification of high risk in 57.61% of the territorial area of 

the municipality. The method used to calculate the susceptibility to contamination of aquifers 

proved to be efficient and suitable for adequate environmental management of the municipality. 

Keywords: Susceptibility Index. Contamination. Aquifers Units. Water resources. GIS. 

 

1. INTRODUÇÃO 

 
Atualmente mais da metade da população mundial reside em áreas urbanas (54%) e estudos 

estimam que em 2050, 66% da população mundial habitará em áreas urbanas (ONU, 2015).  Um 

dos maiores desafios, associados com o crescimento e velocidade das mudanças das paisagens 

urbanas, será a de fornecer água. Com o aumento da densidade populacional, a água adicional para 

o abastecimento da população deve ser organizada a partir de fontes situadas fora dos limites 

geográficos das cidades e em aquíferos (LUNDQVIST et al., 2003; MAZZUCO et al., 2018). 

Com a pressão na disponibilidade hídrica superficial e o uso acentuado das captações 

subterrâneas para abastecimento, cresce o risco de contaminação das unidades aquíferas, desta 

forma, se faz necessário integrar as intervenções antrópicas com os atributos naturais para avaliar o 

potencial de contaminação de aquíferos (COSTA et al., 2020). 

As águas superficiais, como rios, lagos e reservatórios, normalmente são vistas como as 

principais fontes de abastecimento para os mais diversos usos humanos, porém, menos de 3% de 

toda a água doce do mundo está na superfície, sendo que mais de 97% encontra-se no subsolo 

(REBOUÇAS, 2006; PINTO-COELHO et al., 2014). Dados do Ministério do Meio Ambiente 

(MMA, 2007) retratam que 55% dos distritos brasileiros são abastecidos por águas subterrâneas.  

Aquíferos são reservatórios de águas subterrâneas, sendo definidos como unidades 

rochosas aptas a armazenar água, além de sua exploração ser economicamente rentável, 

desempenham importante papel social, servindo de abastecimento para a população ou até mesmo 

como irrigação de lavouras. Atualmente, há um grande crescimento na utilização das águas 

subterrâneas, principalmente nos países subdesenvolvidos, que encontram nessas reservas um 

meio barato e viável para suprir sua demanda de abastecimento (TEIXEIRA et al., 2007; CETESB, 

2015). 

O uso das águas dos aquíferos é uma prática mundialmente difundida, sendo observado em 

muitos países do Oriente Médio, como Índia, China, Japão, em países da Europa (principalmente 

Itália e Países Baixos) como também nas Américas (como Estados Unidos e Chile). No Brasil, 

podemos destacar as regiões Nordeste e Sudeste, em destaque o estado de São Paulo, como sendo 

as que mais utilizam (PINTO-COELHO et al., 2014).  
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Por conta do crescente uso das águas subterrâneas, há um aumento na preocupação de 

preservação destas águas. Neste sentido, destaca-se o Programa Hidrológico Internacional (PHI), 

órgão pertencente à UNESCO, que assumiu a conservação dessas águas como algo prioritário, 

tendo como objetivo a recuperação e o incentivo ao uso sustentável das mesmas (UNESCO-PHI, 

2011; UNESCO-PHI, 2021). 

Para Palmier (2006), o uso das águas de aquíferos depende de características próprias das 

formações geológicas, como por exemplo o perfil geológico e litológico da região, e também da 

permeabilidade das rochas que compõem estas formações, o que permite que a precipitação 

percole até as zonas saturadas. A capacidade de armazenamento de um aquífero depende da 

extensão e espessura da camada de rochas componentes, sendo que as mesmas devem ser 

permeáveis para permitir a percolação (BATISTA, 2017).  

Vianna (1995) descreve que as atividades antrópicas vêm causando danos aos reservatórios 

subterrâneos, gerando inúmeras fontes de contaminação, e essa se dá de forma qualitativa e 

quantitativa. O autor ainda relata que a crescente preocupação com as águas vem forçando as 

autoridades a apresentarem propostas de conservação e também de conscientização social. De 

acordo com Ribeiro et al., (2011), a grande exploração dos aquíferos, juntamente com a ocupação 

irregular em áreas de recarga, põe em risco a qualidade natural das águas subterrâneas, citando 

como exemplo “a exploração mineral e a expansão da cana-de-açúcar, que expõe preocupação no 

que diz respeito à preservação do meio ambiente subterrâneo”.  

Os usos mais comuns das águas subterrâneas, de acordo com Zanatta e Coitinho (2002), 

são para abastecimento urbano. Além disso, contribuem para o abastecimento rural, sendo 

importante para irrigação e dessedentação dos animais; uso industrial, ao qual se destina para 

aproveitamento de energia geotérmica; turismo e lazer, sendo esta última destinada para fins 

terapêuticos e fonte de águas termais. No entanto, observa-se que as águas superficiais se 

encontram contaminadas em grande parte dos municípios (DENIZMAN, 2018). Associado a isso, 

o número de poços clandestinos é superior aos cadastrados, sendo desconhecido os atuais números 

referentes à captação e uso das águas subterrâneas (HIRATA et al., 2019).  

Os aquíferos apresentam graus de susceptibilidade à contaminação que se baseiam em suas 

propriedades físicas, além de sua sensibilidade a impactos naturais e antrópicos, descreve Guiguer 

e Kohnke (2002). Os autores ainda alegam que a susceptibilidade é baseada no contexto de que os 

aquíferos apresentam certo grau de proteção às contaminações, por conta de suas características 

físicas, o que significa que alguns aquíferos são mais vulneráveis que outros. 

Para Ribeiro et al. (2011), as metodologias de avaliação da susceptibilidade servem como 

uma “ferramenta de auxílio às propostas de proteção das águas subterrâneas, associadas a 

atividades de gestão dos recursos hídricos e de planejamento e ordenamento territorial”.  Na 

literatura há várias metodologias utilizadas para avaliar a suscetibilidade de aquíferos, como o 

método DRASTIC de Aller et al., (1987), o método GOD, desenvolvido por Foster e Hirata 

(1988), o método DRASTIC Pesticida utilizado por Bevilacqua (2015), Método de Índice de 

Suscetibilidade (IS), utilizado por Condeça e Chambel (2015) e Borba et al., (2016), dentre outros.  

Um dos métodos mais conhecidos é o Índice de Susceptibilidade (IS), desenvolvido por 

Ribeiro (2000). Este índice consiste em um método paramétrico utilizado para avaliar a 

vulnerabilidade vertical específica das águas subterrâneas quanto à poluição ocasionada 

principalmente por atividades da agricultura, como o uso de fertilizantes e pesticidas que 

interferem consideravelmente na qualidade da água subterrânea. Este método trata-se de em uma 

modificação do método DRASTIC, que inclui o uso e cobertura do solo na análise, no entanto, 

elimina o impacto da zona vadosa e a condutividade hidráulica (GHOUILI et al., 2021). 

 A metodologia IS se destaca pela sua fácil aplicação, levando em conta cinco parâmetros, 

os quais recebem pesos diferentes entre si, sendo este o método adotado no presente trabalho.  
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A escolha deste método se deu ao fato da acessibilidade aos atributos e a facilidade de 

aplicação. Além disto, o mesmo leva em consideração o uso e cobertura do solo, um atributo de 

grande importância ao município de Jaú, que apresenta 65,55% de sua área ocupada por cultivo de 

monocultura, especificamente por cana-de-açúcar. A prática da agricultura intensiva, com a 

utilização de agrotóxicos, tem potencial em causar impactos negativos nos recursos naturais, 

particularmente a contaminação da água dos aquíferos. Neste contexto, o presente estudo tem 

como objetivo avaliar a susceptibilidade das unidades aquíferas do município de Jaú - SP, por 

meio do método de Índice de Susceptibilidade.  

 

2. MATERIAIS E MÉTODOS 

 
2.1 Área de Estudo 

 
O município de Jaú encontra-se na região central do estado de São Paulo, a 296 km da 

capital, entre as coordenadas UTM e 7510010-7550010 Sul ; 740010-770010 Oeste, à 522 metros de 

altitude, numa área de aproximadamente 688 km², incluso na mesorregião de Bauru (BERNARDI 

FILHO, 2005; IBGE, 2019). 

A área urbana do município constitui 82 km² de seu território. O município é um 

importante polo de desenvolvimento industrial e agrícola, sendo a produção de cana-de-açúcar 

uma importante fonte de renda da cidade, além do setor calçadista (IBGE, 2019).  

De acordo com a classificação de Köppen, a região de Jaú encontra-se em clima 

mesotérmico, conhecido como Tropical de Altitude, caracterizado por um verão chuvoso e inverno 

seco. De novembro a março a precipitação média é de 150 mm ou mais, enquanto de abril a 

outubro a precipitação média decresce para 50 mm. As temperaturas médias da região variam de 

21 a 23°C, sendo que janeiro apresenta as médias máximas entre 29 e 32°C, e julho apresenta as 

médias mínimas de 11 a 13°C (SARDINHA et al., 2012).  

O município de Jaú é banhado pelo rio Tietê e pertence a Unidade de Gerenciamento de 

Recursos Hídricos (UGRHI 13), que abrange a Bacia Hidrográfica do Tietê-Jacaré, ao qual está 

inserido o município. A UGRHI 13 é gerenciada pelo Comitê da Bacia Hidrográfica do Tietê-

Jacaré (CBH-TJ), apresentando uma área total de 11.672 km², abrangendo sub-bacias as bacias dos 

rios Jacaré-Guaçu e Jacaré-Pepira, além de áreas que são drenadas diretamente pelo Rio Tietê 

(CBH-TJ, 2016). 

Nessa região, o principal aquífero é o Serra Geral, constituído por derrames basálticos e 

arenitos intertrapeanos, de idade jurássica-cretácea (CORDANI e VANDOROS, 1967). Lastoria et 

al., (2006) relata que a formação Serra Geral é a mais explorada da Bacia do Paraná. O Aquífero 

Serra Geral é uma unidade fraturada, ao qual dependerá da precipitação sobre os solos basálticos 

para a sua recarga, apresentando profundidade de poucos metros até 2.000 metros e é descrito 

como uma unidade que apresenta inter-relação com outros aquíferos (CETESB, 2015). 

Quanto à geologia local, a região é caracterizada com a presença de rochas de sedimento 

clástico, do grupo São Bento, rochas do grupo Bauru, Formação Itaqueri e depósitos correlatos 

(CBH-TJ, 2016). Sua geomorfologia é caracterizada como pertencendo à Província 

Geomorfológica do Planalto Ocidental Paulista e das Cuestas Basálticas (CBH-TJ, 2016). A 

pedologia do município apresenta maior predominância de Latossolos Vermelhos, com textura 

argilosa ou muito argilosa, os quais representam altos valores de óxido de ferro, sendo esse tipo de 

solo o mais utilizado na agricultura (EMBRAPA, 2019). 

No município de Jaú (Figura 1), estão localizadas três unidades aquíferas: Bauru, Guarani e 

Serra Geral, com base nos dados da Companhia de Pesquisa de Recursos Minerais (CPRM, 1989).  
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O Aquífero Serra Geral apresenta ocorrência descontínua, sendo o de maior ocorrência no 

município. 

 
 

 

 
Figura 1. Localização do município de Jaú e das unidades aquíferas. 

 

2.2 Metodologia 

 
 É fundamental avaliar precisamente o nível de vulnerabilidade nos corpos hídricos, pois 

apoia adequadamente os gestores responsáveis pelas ações em regiões hidrográficas (RIBEIRO, et 

al. 2017). A avaliação da vulnerabilidade de águas subterrâneas pode ser feita por meio de 

métodos de índice, estatísticos e de processo como descrito por Focazio et al., (2002). Neste 

trabalho, definiu-se utilizar o método IS sendo um método de índice que adota ponderações ou 

classificação numérica aos diversos planos de informação dos meios físico e antrópico para definir 

os níveis de vulnerabilidade à contaminação. 

Para a avaliação da suscetibilidade dos aquíferos do município de Jaú, foi utilizado o 

método IS, que foi desenvolvido por Ribeiro (2000), e consiste em uma adaptação do índice de 

vulnerabilidade DRASTIC, desenvolvido pela Environmental Protection Agency (EPA), relatado 

por Aller et al., (1987), ao qual de acordo com Guiguer e Kohnke (2002), é um método 

desenvolvido para padronizar a avaliação de vulnerabilidade de aquíferos frente a eventos de 

poluição. 

O IS tem por objetivo avaliar a vulnerabilidade de aquíferos, que se dá por meio da soma 

ponderada de vários parâmetros (CONDEÇA e CHAMBEL, 2015). Os parâmetros de avaliação do 

método IS são cinco: (1) Profundidade da zona não saturada (P); (2) Recarga Líquida (RL); (3) 
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Unidades Aquíferas (UA); (4) Declive do terreno (D); (5) Uso e Cobertura do Solo (UC) (Tabela 

1). O método do IS foi calculado a partir da soma ponderada dos cinco parâmetros descritos 

anteriormente. As etapas realizadas para a confecção da carta de susceptibilidade à contaminação 

dos aquíferos estão apresentadas na Figura 2. 

 

 

 

Tabela 1. Identificação e descrição dos atributos do Índice de Susceptibilidade (IS) de aquíferos. 

Atributo Descrição Fonte Escala 

Uso e Cobertura 

do Solo 

Classes de uso e cobertura 

atribuídas por meio da 

classificação visual 

Trevisan et al., (2018) 1:50.000 

Profundidade 

do Nível 

D’água 

Nível estático dos poços 

cadastrados 

Sistema de Informações de 

Águas Subterrâneas 

(SIAGAS) 

(http://siagasweb.cprm.gov.

br) 

1:50.000 

Declividade 

Classes de declividade, por 

meio do Modelo Digital de 

Elevação, classificada em 

cinco classes 

Vertex Alaska 1:50.000 

Pedologia 

Classificação da ordem e 

subordem das unidades 

pedológicas 

Rossi (2017) 1:50.000 

Unidades 

Aquíferas 

Descrição e classificação 

das unidades aquíferas 
CPRM (1989) 1:50.000 

 

http://siagasweb.cprm.gov.br/
http://siagasweb.cprm.gov.br/


Acta Ambiental Catarinense - Unochapecó                                                           

 

DOI:  http://dx.doi.org/10.24021/raac.v19i1.6024                                                                             Vol. 19, N. 1 (2022) 

  Este é um artigo publicado em acesso aberto (Open Access) sob a licença Creative Commons Attribution, que 

permite uso, distribuição e reprodução em qualquer meio, sem restrições desde que o trabalho original seja corretamente citado. 
7 

 

 
Figura 2. Fluxograma metodológico para aplicação do Índice de Suscetibilidade (IS) de aquíferos. 

Legenda: MB (Muito Baixa), B (Baixa), M (Média), A (Alta) e MA (Muito Alta). 

 

2.2.1 Aquisição da base de dados  

 

Todo o plano de informação foi realizado no software ArcGIS 10.6
®
, dentro do sistema de 

projeção cartográfica Universal Transversa de Mercartor (UTM) e Datum SIRGAS 2000.  A 

Figura 3 apresenta os planos de informação utilizados para a elaboração da carta de 

susceptibilidade à contaminação dos aquíferos no município de Jaú. 
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Figura 3. Planos de informação utilizados para a elaboração da carta de susceptibilidade à 

contaminação dos aquíferos no município de Jaú. 

As obtenções das unidades aquíferas utilizadas no presente trabalho foram obtidas pelo 

portal Companhia de Pesquisa de Recursos Minerais (CPRM, 1989), que disponibiliza a 
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caracterização das unidades aquíferas presentes em todo o estado de São Paulo. Para tanto, foi 

necessário o recorte dos cinco planos de informação utilizados neste trabalho. 

Foi utilizado o mapa pedológico atualizado por Rossi (2017), na qual se tem a classificação 

das unidades pedológicas do estado de São Paulo, que foi recortada para a área de estudo.  O mapa 

de uso e cobertura do solo foi elaborado na escala de 1:50.000 por Trevisan e Moschini (2018), o 

qual foi realizado por meio da classificação visual das imagens LandSat 8, disponíveis na 

plataforma do United States Geological Survey (USGS). 

Para delimitação das classes de declividade foi utilizado o modelo digital de elevação do 

sensor Alos Palsar, coletado em 01/11/2010 e com resolução espacial de 12,5m. Após a obtenção 

das imagens realizou-se a correção das possíveis anomalias entre os pixels (ArcToolbox > Spatial 

Analyst Tools > Hydrology > Fill). Para a descriminação das classes e obtenção da declividade 

utilizou-se a ferramenta Slope (ArcToolbox > Spatial Analyst Tools > Surface > Slope), que teve 

seus intervalos estabelecidos de acordo com o solicitado pelo método IS.  

A profundidade do nível da água foi obtida por meio dos dados disponibilizados pelo 

Sistemas de Informações de Águas Subterrâneas (SIAGAS), responsável pelo cadastro e 

disponibilização dos poços legalizados no Brasil. Após inserção no software, houve a interpolação 

dos dados referentes ao nível estático de cada poço, o método de interpolação adotado foi o IDW 

(Interpolação pela Ponderação do Inverso da Distância). A interpolação pela distância inversa 

ponderada determina os valores da célula por meio de uma combinação linear ponderada de um 

conjunto de pontos de amostra, que no presente estudo, foram 87 pontos. 

A recarga líquida da região foi realizada pela associação dos planos de informações 

(pedológico e unidades aquíferas) no software ArcGIS 10.6
®
 (Geoprocessing > Intersect).   

2.2.2 Atribuição de pesos 

 

O IS foi calculado a partir da soma ponderada dos cinco parâmetros utilizados 

(Declividade, Recarga Líquida, Uso e Cobertura do Solo, Unidades Aquíferas e Profundidade do 

Nível da Água), os quais receberam diferentes pesos de acordo com sua caracterização e influência 

na susceptibilidade à contaminação das águas subterrâneas. Para a determinação dos pesos, foi 

utilizada a ponderação adotada por Simas (2014), possuindo alterações para melhor adequação 

com as características da área de estudo. 

 

Declividade 

 

As cinco classes apresentadas na carta de declividade possuem pesos diferentes devido a 

capacidade de infiltração e escoamento. Segundo Cordani et al. (2000), declives acentuados 

favorecem o escoamento superficial direto, desfavorecendo a infiltração. Portanto, nas áreas com 

declives elevados os pesos foram menores, enquanto as áreas mais planas, por apresentarem alta 

capacidade de retenção que favorece diretamente a percolação, receberam pesos maiores (Tabela 

2). 
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Tabela 2. Pesos atribuídos a cada classe dos planos de informação para a elaboração da Carta de 

Susceptibilidade à Contaminação dos Aquíferos. 
 

Declividade 
Uso e Cobertura 

 do Solo 

Unidades  

Aquíferas 

Profundidade do Nível 

D’água (m) 

Classes Peso Classes Peso Classes Peso Classes Peso 

<0-2% 5 Cana-de-Açúcar 90 
Bauru 4 

< 1,5 5 

2-6% 4 Corpos Hídricos 50 1,5 - 4,6 5 

6-12% 3 Pastagem 50 

Serra Geral 2 

4,6 - 9,1 4 

12-18% 2 
Silvicultura 70 9,1 - 15,2 3 

Solo Exposto 100 15,2 - 22,9 2 

>18% 1 
Urbano 75 

Guarani 5 
22,9 - 30,5 1 

Vegetação Natural 0 >30,5 1 

Recarga Líquida* 

Profundidade 
Tipo de 

solo 
Textura Aquífero Rocha Principal Peso 

PP GH Indiscriminada Serra Geral Basalto 3 

PP GH Indiscriminada Guarani Arenito 5 

MP LV Argilosa e muito argilosa Serra Geral Basalto 1 

MP LV Argilosa e muito argilosa Guarani Arenito 3 

MP LV Argilosa e muito argilosa Bauru Arenito, lamito 2 

MP LV Média Serra Geral Basalto 2 

MP LV Argilosa Serra Geral Basalto 2 

MP LV Argilosa Guarani Arenito 3 

MP LVA Média Bauru Arenito, lamito 3 

MP LVA Média Serra Geral Basalto 2 

MP LVA Média Guarani Arenito 4 

P e R NV Argilosa e muito argilosa Serra Geral Basalto 2 

P NV Argilosa e muito argilosa Serra Geral Basalto 2 

P e R NV Argilosa e muito argilosa Bauru Arenito, lamito 3 

P e R NV Argilosa e muito argilosa Guarani Arenito 4 

P AVA 
Média, argilosa e 

média/argilosa 
Serra Geral Basalto 2 

P AVA Média e média/argilosa Serra Geral Basalto 2 

P e MP AVA 

Média/argilosa, 

arenosa/argilosa e 

arenosa/média 

Serra Geral Basalto 2 

P e MP AVA 

Média/argilosa, 

arenosa/argilosa e 

arenosa/média 

Guarani Arenito 3 

R NL Arenosa e média Serra Geral Basalto 3 

R NL Arenosa e média Guarani Arenito 5 

MP NQ Arenosa Serra Geral Basalto 2 

MP NQ Arenosa Guarani Arenito 4 

AU e Rios, Represas e 

Lagoas 
- Serra Geral Basalto 0 

* R - Raso; PP - Pouco Profundo; P - Profundo; MP - Muito Profundo; GH - Gleissolos Háplicos; 

LV - Latossolos Vermelhos; LVA - Latossolos Vermelhos-Amarelos; NV -Nitossolos Vermelhos; 

AVA - Argissolo Vermelho- Amarelos; NL - Neossolos Litólicos; NQ - Neossolos 

Quartzarênicos; AU -  Área Urbana. 
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Recarga líquida 

 

Como a recarga líquida consistiu na associação da pedologia com as unidades aquíferas, os 

pesos atribuídos foram a média das atribuições dadas a cinco características: (1) Textura do solo, 

(2) Rocha principal, (3) Tipo de solo e (4) Profundidade do solo. 

A textura e o tipo de solo interagem diretamente na capacidade de permeabilidade e 

infiltração da água proveniente da precipitação no solo, que possuem efeitos diretos sobre a 

recarga dos aquíferos (RIBEIRO e MENDES, 2010). Segundo Cordani et al. (2000), solos 

argilosos ou muito argilosos, apesar de possuírem alta porosidade, são praticamente impermeáveis, 

portanto, foram atribuídas às classes de solos argilosos e muito argilosos baixos pesos, enquanto 

solos arenosos e médios, que possuem maior capacidade de permeabilidade e infiltração, os pesos 

foram maiores, devido à susceptibilidade de percolação de águas contaminadas (Tabela 2).  

Conforme determinado por Rossi (2017), as espessuras dos solos são classificadas nas 

seguintes categorias: solos rasos com espessura inferior a 50 cm, solos poucos profundos entre 50 

a 100 cm, profundos 100 a 200 cm e solos muito profundos com espessura igual ou superior à 200 

cm. Nas profundidades elevadas há maior probabilidade de ocorrer depuração por parte do solo de 

possíveis poluentes percolados (RIBEIRO e MENDES, 2010), portanto, os solos com maiores 

profundidades tiveram baixos pesos atribuídos, enquanto que os solos com espessuras menores, 

devido à ausência da distância vertical, que favorece a depuração, o peso atribuído foi maior 

(Tabela 2).  

As rochas predominantes também foram consideradas, sendo identificadas na área de 

estudo a predominância de três tipos principais de rochas: Basalto, Arenito e Arenito Lamito. 

Considerando que quanto mais permeável for a rocha maior serão as chances de susceptibilidade à 

contaminação, ao Basalto foi atribuído pesos menores, ao Arenito Lamito peso intermediário e ao 

Arenito peso elevado (Tabela 2).  

 

Uso e cobertura do solo 

 

Os pesos atribuídos às classes identificadas de uso e cobertura do solo variam de acordo 

com sua influência na permeabilidade e atividades possíveis de aumentar a susceptibilidade à 

contaminação das águas subterrâneas.  

A vegetação natural recebeu peso 0 devido à ausência de ações humanas interferentes que 

possam causar danos ou alterar o fluxo normal de percolação, mantendo a integridade dos 

aquíferos. Áreas urbanas, solos expostos e áreas de cultivos como silvicultura e cana-de-açúcar 

foram classificados com pesos maiores devido à alteração existente no fluxo normal (Tabela 2). 

Segundo Simas (2014), às áreas urbanas alteram as taxas de percolação, devido às 

estruturas criadas, por exemplo, áreas asfaltadas induzem ao aumento do escoamento superficial, 

interferindo de maneira direta na infiltração existente na área, além de possuir principais fontes 

potenciais de contaminação, como armazenamento, manuseio e descarte inadequado de resíduos 

(CETESB, 2015). Atividades agropecuárias também obtiveram grande pontuação devido ao uso de 

agrotóxicos e fertilizantes, fontes potenciais de poluição. O maior peso foi atribuído ao solo 

exposto, devido à inexistência de barreiras de proteção (Tabela 2). 

 

Unidades aquíferas 

 

Na área de estudo, foram identificados três diferentes tipos de unidades aquíferas: Aquífero 

Bauru, Serra Geral e Guarani. O aquífero Bauru constitui-se essencialmente por arenitos, arenitos 
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argilosos e siltitos com ou sem cimentação carbonática, caracterizando o aquífero como uma 

unidade hidrológica sedimentar (CETESB, 2015).  

O aquífero Serra Geral, segundo o Relatório das Águas Subterrâneas (CETESB, 2015), é 

uma unidade hidrológica fraturada e descontínua, constituída por basaltos. Sua recarga é realizada 

por meio da precipitação pluvial em zonas fraturadas expostas. Devido às suas características 

físico-químicas, a taxa de percolação é extremamente baixa, o que permite-lhe atribuir baixo peso 

na classificação dos aquíferos por não possuir grandes influências no processo de percolação. 

O aquífero Guarani é granular e homogêneo, podendo ocorrer livremente ou confinado. Em 

sua composição encontram-se arenitos de granulação média a fina, arenitos eólicos com grande 

grau de esfericidade (CETESB, 2015). Devido à sua importância e composição propícia às altas 

taxas de percolação, este aquífero recebeu maior peso dentre os três aquíferos. 

 

Profundidade do nível d’água 

 

Por meio dos dados obtidos sobre os poços cadastrados na região, obteve-se o nível 

estático da água em cada poço. Este parâmetro influencia diretamente na distância que um possível 

contaminante teria que percorrer até alcançar o aquífero e seu contato com o meio geológico acima 

da unidade. 

Poços que apresentaram maior distância vertical, ou seja, profundidade, foram classificados 

como de baixo peso, enquanto que as menores distâncias tiveram maiores pesos atribuídos, por 

apresentarem menor tempo em contato com o meio geológico da região (Tabela 2). 

2.2.2 Carta de susceptibilidade à contaminação 

 

Para a elaboração da álgebra de mapas, foi necessário transformar o formato dos arquivos, 

de vetoriais para matriciais, por meio das ferramentas (ArcToolbox > Conversion Tools > To 

Raster > Polygon to Raster). 

Após a conversão, os atributos existentes em cada plano de informação foram 

reclassificados (ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify) para que os pesos 

fossem atribuídos. Em seguida, por meio da ferramenta Weight Sum foi realizada a sobreposição 

dos planos de informações (ArcToolbox > Overlay > Weight Sum). Cada parâmetro teve atribuído 

seu peso para o cálculo do índice IS, conforme proposto por Ribeiro (2000), (Tabela 3). 

 

Tabela 3. Peso dos parâmetros para o cálculo do Índice de Susceptibilidade.  

Parâmetro UA UC R D P 

Fator de ponderação 0,259 0,222 0,212 0,121 0,186 

IS = P*0,186 + R*0,212 + UA*0,259 + D*0,121 + UC*0,222 

 
3. RESULTADOS E DISCUSSÃO 

 
A Carta de Susceptibilidade à Contaminação dos Aquíferos (CSCA) foi elaborada com 

base no método IS, vale ressaltar que este método permite obter uma avaliação relativa quanto a 

vulnerabilidade dos aquíferos, pois por meio dele se consegue verificar os locais onde os 

contaminantes tendem a fluir verticalmente até atingir o lençol freático, mas não considera o fluxo 

dos poluentes em águas subterrâneas, porque o método IS não possibilita definir o caminho que os 

poluentes percorrerá no sistema hidrogeológico, desse modo, essa característica do método pode 
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ser considerada como uma desvantagem (GHOUILI et al., 2021). Porém não inviabiliza a sua 

utilização, quando usado para uma análise preliminar pois indica eficazmente as potenciais áreas 

que podem ser contaminadas. 

A classificação da CSCA foi definida em cinco classes: Muito Baixa, Baixa, Média, Alta e 

Muito Alta (Figura 4). A Tabela 4 apresenta as áreas em km² e percentuais correspondentes a cada 

classe.  

 

 
Figura 4. Carta de susceptibilidade à contaminação dos aquíferos do município de Jaú. 

 

Tabela 4. Área (km² e %) das classes de susceptibilidade à contaminação dos aquíferos no 

município de Jaú (SP). 

Classe de susceptibilidade Área (km²) Área (%) 

Muito Baixa (MB) 55,72 8,14 

Baixa (B) 50,52 7,38 

Média (M) 139,58 20,38 

Alta (A) 394,62 57,61 

Muito Alta (MA) 44,48 6,49 

 

• Muito Baixa e Baixa: As áreas com menor índice de susceptibilidade são as que possuem 

vegetação natural, aquelas que margeiam os corpos hídricos. Ribeiro et al. (2017) em trabalho 

desenvolvido no Equador também encontraram na área com menor susceptibilidade, áreas de 

floresta e vegetação nativa, além dos corpos hídricos. 

Esta classe de susceptibilidade foi identificada em todas as unidades aquíferas da região. 

As baixas susceptibilidades também estão associadas às propriedades dos solos, em certos casos, o 
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solo pode atuar como uma barreira de proteção contra a poluição, porém isto poderá ocorrer em função 

das características do solo e do contaminante (ABDELWAHEB et al., 2019). Desta forma, estas 

regiões apresentam extensa profundidade de Nitossolos Vermelho, argiloso e muito argiloso, o que 

causa maior dificuldade de percolação de possíveis contaminantes, que podem estar localizados 

próximos aos corpos hídricos. 

Outro fator também que pode contribuir nas áreas de baixa e muito baixa susceptibilidade é 

a declividade. Na porção sudoeste da região de estudo, observa-se que não apresenta relevante 

cobertura por vegetação nativa. No entanto, há pequenas porções com alta declividade, podendo 

influenciar em uma menor infiltração de água e por consequência, menor peso na susceptibilidade. 

Ayed et al. (2017) e Denizman (2018) também destacam a importância da declividade na aplicação 

do índice, sendo quanto menor a declividade maior a susceptibilidade, uma vez que pode aumentar 

a infiltração de contaminantes. 

Dentre os fatores para a classificação dessa categoria, o que mais se destacou foi a 

ocupação e cobertura do solo, que condicionam áreas com pouca vegetação natural. As áreas com 

Muito Baixa e Baixa susceptibilidade à contaminação dos aquíferos correspondem a 106,24 km², 

sendo apenas 15,52% da área total do município. Em comparação com outros trabalhos, o 

município de Jaú apresentou uma das maiores porcentagens de área nessas categorias, sendo 

encontrado na literatura valores variando entre 9 % (GHOUILI et al., 2021) e 12,1 % (AYED, 

2017). 

• Média: As áreas com média susceptibilidade abrangem majoritariamente áreas de cultivo 

de cana-de-açúcar, silvicultura e parcela da área urbana. Ghouili et al. (2021) também encontraram 

média susceptibilidade nos mesmos tipos de uso e cobertura da terra, dando destaque para as áreas 

agrícolas irrigadas. As ocorrências destas áreas se concentraram ao sul e oeste do município, 

predominantemente sobre o aquífero Serra Geral e sobre a composição de Latossolo Vermelho 

com textura argilosa. Costa et al. (2019) relatam também que as unidades que apresentaram em sua 

área de estudo menor potencialidade de recarga e maior possibilidade de escoamento superficial 

foram as unidades de solo residual da Formação Serra Geral.  
Possuem o nível dos aquíferos em grande profundidade, moderada importância frente à 

recarga dos aquíferos e declives mais acentuados, diminuindo as chances de contaminação, mas 

não as tornando isentas. Esta classe corresponde a 20,38% da área total do município, sendo 

139,58 km². Em comparação com outras regiões onde o mesmo índice foi aplicado, o município de 

Jaú apresenta porcentagens menores na categoria de média susceptibilidade. Em algumas regiões 

da África são encontrados valores em torno de 41 % (GHOUILI et al., 2021), 46 % (AYED et al., 

2017), 61.5 % na Oceania (SHIRAZI et al., 2013) e 24% da Ásia (HUAN et al., 2016). 

• Alta: Os fatores que condicionam as áreas com alta susceptibilidade são caracterizados 

principalmente por possuírem nível de água do aquífero pouco profundo, ocupação do solo 

predominantemente por plantação de cana-de-açúcar e abrangendo quatro unidades pedológicas: 

Latossolo Vermelho, Nitossolo Vermelho, Neossolos e Latossolo Vermelho-Amarelo. São áreas 

com elevada importância para a recarga dos aquíferos e abrange todas as três unidades aquíferas, 

inclusive o Guarani, caracterizado pela grande importância devido sua abrangência e área de 

recarga na região. Esta classe apresenta maior predominância no município, ocorrendo em 57,61% 

(394,62km²) da área de estudo. Outros trabalhos também indicam o predomínio dessa categoria, 

com 41,9 % (AYED et al. 2021) e 50 % (incluindo a classe muito alta) (GHOUILI et al., 2021) 

• Muito Alta: Como observado, a predominância de áreas classificadas como Muito Alta, 

localizam-se na porção leste do município, caracterizado também pela ocorrência de plantações de 

cana-de-açúcar e grandes fragmentos de solos expostos, que reduzem a proteção destas áreas. A 

área norte do município é caracterizada por possuir uma extensa área de recarga de grande 

importância. Os níveis do lençol freático nestas regiões encontram-se em baixas profundidades, 



Acta Ambiental Catarinense - Unochapecó                                                           

 

DOI:  http://dx.doi.org/10.24021/raac.v19i1.6024                                                                             Vol. 19, N. 1 (2022) 

  Este é um artigo publicado em acesso aberto (Open Access) sob a licença Creative Commons Attribution, que 

permite uso, distribuição e reprodução em qualquer meio, sem restrições desde que o trabalho original seja corretamente citado. 
15 

 

desse modo, quanto menor a profundidade do aquífero, maior será a suscetibilidade às alterações 

nas águas subterrâneas em decorrência de ações antrópicas (LUNARDI et al., 2021), o que 

associado com a ausência de vegetação (solo exposto) e cultivo de cana-de-açúcar, onde pode 

ocorrer o uso de agrotóxicos e fertilizantes, torna a região com alta susceptibilidade à 

contaminação dos aquíferos. Esta classe corresponde a 6,49% da área total do município. 

Uma vez que o IS se diferencia por integrar o parâmetro do uso da terra na sua análise, 

observa-se que as atividades agrícolas se destacam principalmente nas categorias média, alta e 

muito alta. Esses resultados são condizentes com a validação do índice pelo trabalho de Stigter et 

al. (2006) no quesito da avaliação do impacto provindo da agricultura. Nesse sentido, uma das 

maiores atenções é relacionado à contaminação provinda dos agrotóxicos e fertilizantes. Segundo a 

FAO (2014) grande parte das áreas agrícolas que não apresentam boas práticas na agricultura, 

apresentam grande risco de contaminação.  Na região de Jaú, uma das fontes de fertilização das 

áreas de cana é o uso da vinhaça, a qual é um subproduto da produção sucroalcooleira. Alguns 

estudos destacam o impacto da vinhaça nas águas subterrâneas por meio da lixiviação (SILVA et 

al., 2007), ultrapassando valores de referência para a potabilidade da água (LOFRANO et al., 

2016). Deve-se ressaltar que esse impacto está diretamente relacionado com outros fatores, como 

as propriedades físicas e químicas do solo (HUAN et al., 2016), profundidade do lençol freático e 

a quantidade de aplicação (MEURER et al., 2000).  

Dessa maneira, a utilização do IS apresenta-se altamente recomendada para regiões como 

grande predomínio das atividades agrossilvipastoris, esses mesmos resultados foram citados em 

trabalhos desenvolvidos no Iran (ASADI et al., 2017), na Tunísia (AYED et al., 2017) e na 

Malásia (SHIRAZI et al., 2013). 

 

4. CONSIDERAÇÕES FINAIS 

 

O método aplicado para obtenção da susceptibilidade à contaminação dos aquíferos 

mostra-se satisfatório e condizente para a adequada gestão ambiental no município de Jaú, pois 

possibilitou a identificação de áreas que apresentam alta susceptibilidade à contaminação e que 

necessitam de controle e manejos adequados das atividades exercidas sobre estes locais, 

principalmente a atividade predominante no município: cultivo da cana-de-açúcar. Neste sentido, 

recomenda-se o monitoramento dos solos, recuperação de áreas expostas e uso racional de 

agrotóxicos e fertilizantes. 

Além da usualidade para o auxílio do ordenamento territorial, os resultados obtidos 

também poderão ser utilizados para auxiliar na delimitação de áreas adequadas para a 

implementação de poços de monitoramento, poços de abastecimento e alocação de construções 

que podem vir a ser potenciais poluidores, dentre outras atividades, de forma, a contribuir com o 

manejo adequado das atividades exercidas no município, assegurando assim, a qualidade 

ambiental e social conciliada ao desenvolvimento. 

Como sugestões para futuros trabalhos, indicamos a necessidade de identificação das 

principais áreas de recarga do aquífero do município e a proteção destas, além da realização de um 

plano de monitoramento da qualidade da água subterrânea, considerando a susceptibilidade à 

contaminação do aquífero e também áreas com maior vulnerabilidade ambiental. 
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